
Section 2

Tasks



T his section describes typical Deathmatch Maker tasks you need to use
when building levels, working with files, and exporting to Quake.

SELECTING 3-D GALLERIESSELECTING 3-D GALLERIESSELECTING 3-D GALLERIESSELECTING 3-D GALLERIESSELECTING 3-D GALLERIES

To select a new gallery, click the left-mouse button on the galleries drop-down
arrow, then drag down the list to highlight the desired gallery name, and
release the mouse button. The selected gallery will be displayed in your
Gallery View until you select another 3-D gallery.

USING A BASIC 3-D GALLERY OBJECTUSING A BASIC 3-D GALLERY OBJECTUSING A BASIC 3-D GALLERY OBJECTUSING A BASIC 3-D GALLERY OBJECTUSING A BASIC 3-D GALLERY OBJECT

Quake spaces, such as rooms and corridors, are usually assembled from
templates. But you can create rooms and corridors from scratch without using
templates. Point to an object in the Basic shapes 3-D Gallery and click to select
it. At the bottom of the Gallery Window, you see a 3-D representation of the
highlighted object. Click on the Rotate buttons at the bottom of the Preview
Area to rotate the highlighted object in 3-D.
To move the selected gallery object to the Design Window, drag it from the
Gallery View to the Design Window. Position the object, and then release the
mouse button. A 2-D object outline appears in the Design Window where you
released the mouse button, and a 3-D object appears in the Walk Window.
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 MODIFYING AN OBJECT MODIFYING AN OBJECT MODIFYING AN OBJECT MODIFYING AN OBJECT MODIFYING AN OBJECT

After dropping an object into the Design Window,
you can move it by dragging it with the mouse
cursor. You can also edit the object's scale and
rotation with the following procedures.
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To reshape an
object, point to a

solid handle,
click, and drag

it in any
direction.

 SELECTING AN OBJECT SELECTING AN OBJECT SELECTING AN OBJECT SELECTING AN OBJECT SELECTING AN OBJECT

Before you can edit an object, you must select it. A selected object displays
handles at its vertices. You can select an object in the Design Window or in the
Walk Window.

SELECTING AN OBJECT IN THE DESIGN VIEW

Click Select Object Tool in the Tools Pad, point to the object that you want
to select, and click.

SELECTING AN OBJECT IN THE WALK VIEW

Click Select Button in the bottom of the Walk Window, point to the object
in the Walk Window that you want to select, and click. The selected object
appears in the center of the Design Window.

GROUPING OBJECTSGROUPING OBJECTSGROUPING OBJECTSGROUPING OBJECTSGROUPING OBJECTS

To group objects, select multiple objects with the Select Object Tool. Under the
Design menu, select Group. Grouping objects causes the selected objects to
be treated as a single object, so the objects move, rotate, and scale together.

LAYERING OBJECTS: ADDING A NEW LAYERLAYERING OBJECTS: ADDING A NEW LAYERLAYERING OBJECTS: ADDING A NEW LAYERLAYERING OBJECTS: ADDING A NEW LAYERLAYERING OBJECTS: ADDING A NEW LAYER

Deathmatch Maker allows you to create your drawing in layers so you can
control the complexity of your Design Window. You may create layers for
different types of objects, which allows you to group certain objects in
different ways. Under the Design menu, choose New Layer. The Layer Name
dialog will appear. Enter the name of the new layer and then click OK. Notice
that the new layer name is now displayed in the Layer List.

You can also drag a line
between two handles to
reshape an object.

Solid handles can be manipulated by dragging.
Hollow handles are limited in their manipulation
capabilities. Gray handles indicate a grouped
object. Red handles indicate a rigid object, and
they cannot be manipulated.
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LAYERING OBJECTS: MOVING AN OBJECT TO A NEW LAYERLAYERING OBJECTS: MOVING AN OBJECT TO A NEW LAYERLAYERING OBJECTS: MOVING AN OBJECT TO A NEW LAYERLAYERING OBJECTS: MOVING AN OBJECT TO A NEW LAYERLAYERING OBJECTS: MOVING AN OBJECT TO A NEW LAYER

Select the object you want to layer. Double-click the name of the layer you
want to add it to in the Layer List. A dialog will be displayed for you to verify
the move. Click OK.

RESHAPING OBJECTSRESHAPING OBJECTSRESHAPING OBJECTSRESHAPING OBJECTSRESHAPING OBJECTS

In addition to selecting objects, the Select Object Tool is
also used to reshape objects. To resize an object, point to
an object handle with the Select Object Tool and drag the
handle.
If an object is grouped, the Select Object Tool cannot be
used to reshape the grouped object. The grouped object
must be ungrouped (with the Ungroup command under
the Design menu) before the Select Object Tool can
reshape the pieces.
Depending on what dimensions you are viewing in the Design Window (Top,
Front, or Right), the reshaping capability of the Select Object Tool may be
limited. Object handles indicate to what extent an object can be reshaped.
When you drag a handle, an object maintains its type. For example, if you drag
the handle of a rectangular object, the object remains rectangular. If you drag
a handle of an octagon, the object remains an octagon. This is true for regular-
shaped objects; however, handles of irregular-shaped objects move individually.
If you hold down the Ctrl key while dragging a handle of a regular-shaped
object, the object becomes irregular.
You can also drag a line between two handles for certain handle types,
depending on the type of handles.

SCALING OBJECTSSCALING OBJECTSSCALING OBJECTSSCALING OBJECTSSCALING OBJECTS

The Resize Object Tool scales or resizes an object about its center or about a
specified anchor point.
You can resize objects independently along the three coordinate axes (dimen-
sions). To resize an object uniformly in all dimensions (X, Y, and Z), hold down
the Shift key before dragging.
When an object is resized, its contents and any surface features are resized
proportionally. If this not what you want, use the Select Object Tool to reshape
the object.

RESIZING AN OBJECT ABOUT ITS CENTERRESIZING AN OBJECT ABOUT ITS CENTERRESIZING AN OBJECT ABOUT ITS CENTERRESIZING AN OBJECT ABOUT ITS CENTERRESIZING AN OBJECT ABOUT ITS CENTER

Select the object to be scaled, select Resize Object Tool,
point to a reference point (such as a corner), and drag the
object to its new size.
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Resizing about
an object center.

If you hold
down the Ctrl
key when you
drag a handle,
you can change
the object type;
that is, a
rectangle is no
longer a
rectangle.
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RESIZING AN OBJECT ABOUT A SPECIFIED ANCHOR POINTRESIZING AN OBJECT ABOUT A SPECIFIED ANCHOR POINTRESIZING AN OBJECT ABOUT A SPECIFIED ANCHOR POINTRESIZING AN OBJECT ABOUT A SPECIFIED ANCHOR POINTRESIZING AN OBJECT ABOUT A SPECIFIED ANCHOR POINT

Select the object, select Resize Object Tool, and point to
the desired location of the anchor point. Hold down the Ctrl
key and click to establish the new anchor point. Point to a
reference point and drag to a size.
If you add a surface feature to an object and then resize the
object, the surface feature is automatically resized to
match the new scale of the object.

SKEWING OBJECTSSKEWING OBJECTSSKEWING OBJECTSSKEWING OBJECTSSKEWING OBJECTS

Skewing means to distort an object from its symmetrical form, taking it out of
plumb. You can use the Skew Object Tool to skew on more than one axis but
only from the view (or opposite view) in which the object was created.
Select the object you want to skew and select Skew Object Tool. Point inside
the object outline, click, and drag in the direction(s) you want to skew.

R O T A T I N GR O T A T I N GR O T A T I N GR O T A T I N GR O T A T I N G OBJECTSOBJECTSOBJECTSOBJECTSOBJECTS

The Rotate Object Tool is used to rotate an object.
When rotating an object, this tool works in any

view (Top, Front, or Right), thus allowing rotation
around more than one axis.
Select the object that you want to rotate, select Rotate
Object Tool, and point to any location in the Design Window
to establish the center of rotation. Drag the pointer away

from the center of rotation. A dotted line appears between
the pointer and the center of rotation.

As you drag the pointer farther from the center of rotation, you gain finer
control over the angle of rotation. Drag the pointer in an arc around the center
point to rotate the object.
If Snap to Grid is selected (see Design menu), when you rotate the object or
surface feature, the rotation snaps to 5 degree increments.
If you hold down the Shift key when you rotate the object, the rotation is
constrained to 15 degree increments.
Contained objects are rotated with the container unless you hold down the Ctrl
key when you rotate an object. Holding the Ctrl key rotates the container but
not the contained objects.

 MODIFYING AN OBJECT SURFACE MODIFYING AN OBJECT SURFACE MODIFYING AN OBJECT SURFACE MODIFYING AN OBJECT SURFACE MODIFYING AN OBJECT SURFACE

You can modify entire objects as described in the previous section, but you can
also modify individual object surfaces. You can drag a surface feature texture
from the Basic 2-D Gallery and drop it onto the surface.
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Resizing about
a specified

anchor point.

Drag from
the center of

rotation out-
ward, and then

drag in an arc.
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 SELECTING AN OBJECT SURFACE SELECTING AN OBJECT SURFACE SELECTING AN OBJECT SURFACE SELECTING AN OBJECT SURFACE SELECTING AN OBJECT SURFACE

Before editing an object surface, you must select it. Like an object, a selected
object surface displays handles at its vertices. You can select an object surface
in the Design Window or in the Walk Window.

SELECTING AN OBJECT SURFACE IN THE DESIGN VIEW
Select Surface Editor Tool, then click on the surface that you want to select.
(You can select a surface that is perpendicular to your view or you can select
a line representing a surface that is perpendicular to your view.)

SELECTING AN OBJECT SURFACE IN THE WALK VIEW
Select 3-D Select Surface Button, then point to the 3-D surface in the Walk
Window and click.
The selected surface is displayed in the Design Window and is aligned planar
to your view. When the surface is displayed, you will notice that the title bar
of the window has changed and the Tools Pads has also changed. This set of
tools and window is called the Surface Editor.

LOCKING AND UNLOCKING AN OBJECTLOCKING AND UNLOCKING AN OBJECTLOCKING AND UNLOCKING AN OBJECTLOCKING AND UNLOCKING AN OBJECTLOCKING AND UNLOCKING AN OBJECT

Select Lock Object Tool. Click the object that you want to lock. The object
cannot be selected or edited in any way until it is unlocked. To unlock an object,
make sure it is selected, then select Unlock All from the Edit menu.

ADDING A HANDLEADDING A HANDLEADDING A HANDLEADDING A HANDLEADDING A HANDLE

Select the surface feature you want to modify and select Add/Remove Handle
Tool. Point to the segment of the outline where you want to add the new handle
and click. Depending on the complexity of the surface feature and the speed
of your machine, there may be a brief pause before the handle appears. If a
handle does not appear, select Add/Remove Handle Tool, point to the location
on the outline where you want the new handle, click, and drag the surface
slightly outward.

REMOVING AN EXISTING HANDLEREMOVING AN EXISTING HANDLEREMOVING AN EXISTING HANDLEREMOVING AN EXISTING HANDLEREMOVING AN EXISTING HANDLE

Select Add/Remove Handle Tool, point to the handle, and click. Again,
depending on the complexity of the object or surface feature and the speed of
your machine, there may be a brief pause before the handle disappears.
You can reposition a new handle when you add it by dragging instead of
clicking.

Note: If your goal is to create an irregular object or surface feature, you might
want to try the Create Irregular Object Tool instead of the Add/Remove Handle
Tool. Both tools can accomplish the same result, but you may prefer one
method over the other.
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MODIFYING THE OPACITY OF AN OBJECTMODIFYING THE OPACITY OF AN OBJECTMODIFYING THE OPACITY OF AN OBJECTMODIFYING THE OPACITY OF AN OBJECTMODIFYING THE OPACITY OF AN OBJECT

The opacity of an object can be changed with the Opacity Modifiers: Make
Opaque and Make Transparent. Opacity Modifiers determine whether the
entire object has opaque or transparent surfaces.
To modify the opacity of an existing object, select the object and choose an
opacity type in Tools Pad. You can also modify an object’s opacity by double-
clicking Opacity Modifier in the Tools Pad.

SELECTING A 3-D GALLERY OBJECTSELECTING A 3-D GALLERY OBJECTSELECTING A 3-D GALLERY OBJECTSELECTING A 3-D GALLERY OBJECTSELECTING A 3-D GALLERY OBJECT

To add Quake features using Deathmatch Maker, choose Quake objects from
the 3-D galleries and add them to your world or level design. To do so, select
a 3-D gallery. Point to an object in the selected 3-D gallery and click to select
it. At the bottom of the Gallery Window in the Preview Area, you see a 3-D
representation of the highlighted object. Click the Rotate buttons at the bottom
of the Preview Area to rotate the highlighted object in 3-D. Within the Design
Window, you can use the Select Object Tool and Rotate Object Tool to
manipulate the 3-D objects. These objects have predefined Quake object
properties and are ready for Quake export.

SELECTING TEXTURE GALLERIESSELECTING TEXTURE GALLERIESSELECTING TEXTURE GALLERIESSELECTING TEXTURE GALLERIESSELECTING TEXTURE GALLERIES

Click on the Textures tab, then on the Preview Area drop-down arrow to display
a pop-up menu for adding textures. Select Add Textures, and a list box provides
a gallery of textures (the textures in the Virtus .wad file). Select the texture you
want to add and click OK. To select more than one texture, hold down the Shift
or the Ctrl key, select the other textures you want, and click OK. The textures
are added to your Texture View.

ADDING TEXTURES TO OBJECTSADDING TEXTURES TO OBJECTSADDING TEXTURES TO OBJECTSADDING TEXTURES TO OBJECTSADDING TEXTURES TO OBJECTS

There are three ways to add textures to objects:

1. Select a texture from the Texture Window. You see a close-up view
of the highlighted texture in the Preview Area. Drag the texture from
the Textures Window onto a 3-D object in the Design View Window.
The texture appears on the 3-D object in the Walk View Window. You
can also drop textures onto a 3-D object in the Walk View.

2. Select the texture, select Auto Texture Tool in the Walk View, and
click on the surface where you want to place the texture.

3. Select an object and double-click on the texture you want to use on
the selected object.

Note: When you apply a texture by dragging, you apply it only to the surface
you drag it to. When you apply a texture using the Auto Texture Tool, you
apply it to the surface you selected and its opposite side. So, if you use the
Auto Texture tool to apply a texture to an inside, it is applied to the outside
surface, also.
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MANAGING YOUR FILESMANAGING YOUR FILESMANAGING YOUR FILESMANAGING YOUR FILESMANAGING YOUR FILES

CREATING AND OPENING FILESCREATING AND OPENING FILESCREATING AND OPENING FILESCREATING AND OPENING FILESCREATING AND OPENING FILES

To create a new file for your level in Deathmatch Maker, choose New under
the File menu. If you wish to open an existing level, choose Open under the File
menu and use the Open dialog to select the Deathmatch Maker file that you
wish to open.

Note: You can only open Deathmatch Maker files. (.dmm).

EXPORTING YOUR FILEEXPORTING YOUR FILEEXPORTING YOUR FILEEXPORTING YOUR FILEEXPORTING YOUR FILE

Before you can use your new level in Quake, you will need to export it from
Deathmatch Maker to Quake and compile it. If none of the export options are
chosen in the Export Quake World dialog, a .map file is written that contains
the text representation of your Deathmatch Maker level. The .map file is the
uncompiled (unexported) source for a .bsp file.
CREATE .BSP FILE: Selecting this option will create a basic Quake world from
your currently open .dmm file. You must select this option to see and run your
level in Quake.
COMPILE LIGHTING ITEMS: Selecting this option will use your light objects
(like torches, globes, and light spheres) to make lit areas and shadows in your
level.


